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Brief Instructions for Using FLT GPS Track and Waypoint Data – Garmin GPSmap 60CSx, 60Cx, 
76CSx, and 76Cx – With Garmin MapSource Topo U.S. 

(Instructions	are	similar	for	Garmin	Etrex	Legend	HCx	and	Vista	HCx)	

“Java	Joe”	Dabes,	kabjnd@msn.com	

 
 Waypoint Abbreviations in FLT .gpx Files: 

 Jct = Junction, CR = County Route, Trl= Trail, Crk = Creek, N = North, E = East, S = South, W = West 

 Waypoint Symbols: 

   Denotes a hunting closure.  M19aO15D20 means “Map M19, Oct. 15 – Dec. 20.”  The first on this map 

is labeled “a,” the second “b,” etc.  M19aMay means a hunting closure for whole month of May.  Note the 

red track (M19X1HntClose is a track name) shows the extent of the closure.   

   or   denote trailhead waypoints.    means parking is nearby. 

 Tracks: 

 Main trail (white blazes) is black, orange trails are dark yellow, blue trails are blue, future trails are magenta, 

and hunting closures are red. 

Brief Instructions 

1. Fire up MapSource Topo or Trip or “Trip & Waypoint Manager” that came free with your Garmin GPS unit.  If 

using “Trip & Waypoint Manager” see Appendix of “Detailed Instructions…” for how to download free 1:24,000 

NY State Topo map from www.gpsfiledepot.com. 

2. Turn your GPS unit on.  If indoors you may wish to “Use with GPS off.” 

3. If you have an active track, saved tracks, or waypoints you would like to save in MapSource Topo, connect GPS 

to your computer with USB cable.  Click   “Receive from Device” and save those tracks and waypoints you 

wish to save, with meaningful names. 

4. Make sure track logging is turned on in order to see your “bread crumb” active track. 

5. Delete Saved Tracks (unit can hold up to 20 Saved Tracks) that you now don’t need. 

6. Change the color of the active track from black (which is the color of the main trail in the .gpx files) to some 

other color; I suggest green. 

7. Clear waypoints you don’t need, maybe all of them. 

8. Load topo maps from MapSource Topo for the areas you will be hiking, if you already haven’t. 

9. In MapSource Topo load the FLT map you want.  Delete any tracks you don’t need (for example, delete a hunting 

closure section if you are not hiking during hunting season). 

10. Send the tracks and waypoints to your device. 

11. Repeat steps 9. and 10. for any other maps you wish to send to your GPS unit. 

12. Out in the field zoom in so the scale in lower left is 500 ft or less, and hike.  You will be able to get back on track 

if you miss a turn. 

 

I suggest you skim the “Detailed Instructions…” for useful info such as downloading the free highly accurate 1:24,000 NY 

Stat Topo map, saving batteries, logging .gpx tracks, and retrieving .gpx tracks from the Micro SD data card (poorly 

documented in manual). 

 
60CSx Brief Instructions.Doc – Oct. 22, 2011 
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Detailed Instructions for Using FLT GPS Track and Waypoint Data – Garmin GPSmap 60CSx, 
60Cx, 76CSx, and 76Cx – With Garmin MapSource Topo 

(Instructions	are	similar	for	Garmin	Etrex	Legend	HCx	and	Vista	HCx)	

	

 GPS Keys:  

 ROCKER:  Allows you to scroll to (highlight) an 

item on a menu.  On Map page moves the 

cursor around on the map. 

 IN:  Zooms in on Map and Altimeter pages; 

works as “Page up” in screen full of menu items. 

 OUT:  Zooms out; works as “Page down” in 

screen full of menu items. 

 FIND:  Allows you to find waypoints, cities, 

interstate exits, etc. 

 PAGE:  Moves forward a page; also backs you 

out of a menu for that page. 

 MARK:  Creates a waypoint where you are 

located or where you want to be. 

 MENU:  Brings up the menu for the page or item 

highlighted. 

 QUIT:  Backs up, including moving backwards a 

page! 

 ENTR:  Chooses the highlighted item on a page. 

 GPS Main Pages: 

 Satellite:  shows satellite locations and signal strengths. 

 Trip Computer:  shows Odometer, Moving Time, Stopped Time, Moving Average Speed, Overall Average 

Speed, and Elevation.  Fields displayed can be modified; see manual. 

 Map:  shows where you are on a topo map (if you have downloaded such into the unit) and “bread crumb” 

track of where you have been.  Fields displayed can be modified; see manual.  I use Speed, Heading, 

Elevation, and Trip Odom. 

 Compass:  shows direction you are heading.  If you have chosen a waypoint to “Go To”, it shows an arrow 

pointing to it and the remaining distance to it. 

 Altimeter:  shows elevation profile for your active track. 

 Main Menu:  Allows you to go to Tracks, Routes, Setup, etc. 

 Waypoint Abbreviations in FLT .gpx Files: 

 CR = County Route, Trl= Trail, Crk = Creek, N = North, E = East, S = South, W = West 

 Waypoint Symbols: 

   Denotes a hunting closure.  M19aO15D20 means “Map M19, Oct. 15 – Dec. 20.”  The first on this map 

is labeled “a,” the second “b,” etc.  M19aMay means a hunting closure for whole month of May.  Note the 

red track (M19X1HntClose is a track name) shows the extent of the closure.   

  or   These denote trailhead waypoints.    means parking is available. 

Back on trail; 

on GPS I can 

see it is to 

my right! 

Realize 

I’m lost!

Official FLT 

GPX “Saved 

Track” 

My hiking 

(active) track 

following old 

false trail not 

blackened out 

My actual hiking experience on western FLT. 
The GPS track of my travels is green.
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 Tracks: 

 Main trail (white blazes) is black, orange trails are dark yellow, blue trails are blue, and hunting closures are 

red. 

Preliminaries: 

1. You will need MapSource Trip & Waypoint Manager that came free on CD with your GPS unit and download the 
free New York Topo maps (or other state topos) as described in Appendix at end.  Note: You can get MapSource 
Trip & Waypoint Manager free if it didn't come with your GPS unit.  See 
http://www.gpsfiledepot.com/tutorials/how‐to‐install‐mapsource‐if‐it‐didnt‐come‐with‐your‐gps/  

2. Fire up MapSource. 
3. Make sure waypoint names are set to at least 14 characters:  From top menu click: Edit>Preferences…>Waypoint 

tab, and change “Limit application created names” to 14 characters; type 14 in the box.  Click OK. 

4. From top menu click View>Show Toolbars>Show All Toolbars.  You now see the following or similar near the top: 

 

5. Hover your cursor over each tool to see what it does and become familiar with their names.  For example   

says “Zoom In” (try it by clicking on it!) and    says “Hand Tool.”  Hand Tool allows you to drag the map if you 
hold the left mouse button down as you drag (try it). 

6. An important tool is   “Zoom Tool”.   After clicking it, move cursor to map, hold left mouse button down, and 

drag a rectangle to zoom into the area of the rectangle.  Make sure you try this! 

7. The “Selection Tool”   is the one you should click after using other tools.  Having it as the default tool helps 

prevent goofy things from happening.  Use it to select tracks and waypoints on the map; they turn yellow to 

indicate they have been selected.  With the cursor over the selected yellow object, right click mouse and you see 

many things you can do with the selected object.  Click away from the selected object to unselect it.  Hint: You 

can also select multiple tracks and waypoints from the tab items on the left by holding down "Shift" or "Ctrl" 

keys. 

8. Your GPS unit: Turn it on.  If indoors you might wish to use it with GPS off: once you see the satellite page, press: 

MENU, use rocker to highlight Use with GPS off >ENTR, to use it with GPS off. 

9. If you have an active track, saved tracks, or waypoints you would like to save in MapSource Topo, connect GPS 

to your computer with USB cable.  Click   “Receive from Device”.  Your device should be automatically 

recognized.   Make sure Waypoints and Tracks are checked if you want both to go to MapSource.  Click Receive 

button.  Once these are transferred to MapSource, make sure you save the file   “Save” with a descriptive 

name (map and/or area and/or date). 

10. Make sure track logging is turned on in order to see your “bread crumb” active track: MENU>MENU (Tracks 

should be highlighted) >ENTR.  Make sure Track Log is turned on ().  If not use rocker to highlight Track Log  

On>ENTR. 

11. While still on Track page here’s how to delete all Saved Tracks (unit can hold up to 20 Saved Tracks).  Look at 

Saved Tracks; if you have some Saved Tracks use rocker to scroll down to Saved Tracks until one of them is 

highlighted>MENU, highlight Delete All Saved>ENTR.  You should now see no Saved Tracks listed. 

12. Now change the color of the active track from black (which is the color of the main trail in the .gpx files).  On the 

Tracks page highlight Setup>ENTR, which takes you to Track Log Setup page.  Highlight Color>ENTR.  Scroll down 

to (highlight) Green>ENTR.  You can back out of this page by hitting QUIT as many times as necessary. 
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13. To clear all your waypoints (unit can hold 1000 waypoints): FIND>ENTR (with Waypoints highlighted)>MENU, 

highlight Delete… >ENTR>All Symbols>ENTR, highlight Yes>ENTR.  You should now see no waypoints listed. 

Load NY State Topo Maps into GPS:  

(Note: you can purchase a 1 or 2 GB Micro SD card ($10 ‐ $20) to replace the 64 MB one that came with your GPS, so you 

can load topo maps for NY state and other states as well. 

1. Have MapSource running (see Appendix at end to download the free New York Topo map or other state topos).  

2. In upper left of MapSource make sure “New York Topo” is showing. 

3. Turn on GPS and connect to computer with USB cable. 

4. Scale to show NY State using Zoom In, Zoom Out, Zoom Tool, and/or Hand Tool.  Or use the scroll bars on the 

right and bottom of MapSource Topo. 

5. Click   “Map Tool”.  Hold down left mouse button and drag to select areas of interest (at least the area of the 

FLT across the NY state, if not much more with bigger Micro SD card).  Click   “Send to Device” (your GPS 

device should be recognized), check () maps, and un anything else>Send.  Topo maps are loaded to your GPS.  

This may take some time if you have selected a large area.  When done you may wish to save your map selection 

file by clicking   “Save” with a meaningful name for future reloading of these maps. 

 

Load FLT Tracks and Waypoints to GPS: 

1. In MapSource, click   “Open.”  Browse to the folder where you stored the FLT GPX files (e.g. CD they came on, 

My Documents\FLT GPX Files or C:\FLT GPX files).  Open this folder.  Near the bottom of this Open window, to 

the right of “Files of Type:” click the down arrow   and click on “GPS eXchange Format (*.gpx).” 

2.  You should now see the 52 .gpx map files.  Highlight (scroll to) the one you want, click on it, then click Open 

button.  Track of that map opens.  On left side of MapSource you see similar to this after clicking on Tracks tab 

to see loaded tracks:      This is for Map M18.  Right click on the main 

track you loaded (M18 in this example) and click on “Show Selected Track on Map.”  MapSource now zooms to 

that track, and you now see the track as “Selected” (yellow).  Click   and click on the map away from the 

yellow track to deselect and see its true color (black for main trail and blue or dark yellow for branch, loop, or 

spur trails). 

3. You may wish to delete some of these tracks.  In the M18 example above, you may not be hiking during hunting 

season, so you might wish to delete the “M18X1Hntclose” red track.  To do so, simply right click on it (left side 

panel shown above), then click “Delete”.  Repeat for others you wish to delete. 

4. You may wish to add tracks (such as the Public Land Boundaries now available for free). To add these tracks start 

a second instance of MapSource and open the file you want (e.g. M18PubLands.gpx), select the tracks you want 

(hold down ctrl to select more than one, right click, and choose "Copy."  Then go to the first instance of 

MapSource, right click, and choose "Paste."  This is a slick trick; starting multiple instances of MapSource and 

copying and pasting tracks and/or waypoints between them! 
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5. Your unit can hold a maximum of only 20 tracks, so make sure that the number of tracks in MapSource (plus the 

number of Save Tracks in your GPS) does not exceed 20. 

6. Make sure your GPS is on and connected to computer with USB cable.  Click   “Send to Device” (your device 

will be recognized).  Make sure tracks and waypoints are checked.  Click Send; tracks and waypoints are sent to 

your GPS.  You may wish to un “Turn off GPS after each transfer” if you want to load more maps.  Click OK 

button.  To check that tracks are there: MENU>MENU>ENTR takes you to the Tracks page.  You should see one 

or more Saved Tracks.  To view a track: Scroll down to a saved track: ENTR> (make sure Show on Map is 

checked), highlight Map>ENTR.  QUIT, QUIT… as many times as needed to back out to whatever page you want 

to be on. 

7. Repeat the above 4 steps for any other maps you wish to load to your GPS, up to 20 saved tracks (less if you 

want to save your tracks after each day of a several day hike).  Do not save any FLT files that you have deleted 

tracks from. 

Out in the Field, Ready to Hike at Trailhead 

1. Turn GPS on.  Wait for at least 4 satellites to be acquired.  Press PAGE to go to Trip Computer page.  Press 

MENU>Reset…>ENTR.  Make sure everything except last 3 items are  (checked).  If need be, highlight items to 

check/uncheck them.  Highlight Apply>ENTR, highlight OK>ENTR.  Trip Computer page is cleared. 

2. Press PAGE to go to Map page.  Press IN button repeatedly until scale in lower left is 500 ft or less. 

3. Start hiking.  If you lose the trail, look at your GPS, perhaps zooming in (IN button) to see where the real trail 

track is relative to your position. 

Saving Batteries 

 Turn off electronic (magnetic) compass:  Hold down PAGE key a few seconds.  Note: electronic compass 

must be recalibrated each time you change batteries, and is of no use if you are moving, so I leave it off. 

 Turn off backlighting:  Backlighting is not needed except in poor light conditions.  MENU>MENU, highlight 

Setup> ENTR, highlight Display>ENTR to show Display Setup page.  Highlight Backlight Level> ENTR to show 

brightness control.  Use ROCKER to lower it to 0%, and then QUIT when brightness control disappears.  

Note!  You can override the above setting by briefly pressing power key, then using rocker to increase 

backlighting to the desired level.  Each time you press a key backlighting is turned on for whatever time 

interval you have chosen (default is 15 seconds).  This is then in effect until you turn your GPS off. 

Other Useful Information 

 Waypoints, a location on the map 

 Creating waypoints: 

 Where you are:  MARK>ENTR. 

 Where you want to be:  From Map page use ROCKER to move cursor to desired location>ENTR (if 

message No map info…, highlight Yes> ENTR), then highlight Go To or Map>ENTR.  If you have 

chosen Go To, the Compass page shows direction with arrow and distance to this waypoint. 

 Using latitude and longitude:  MARK, highlight location field>ENTR to open on‐screen keypad.  Use 

ROCKER to enter location coordinates (default is degrees, decimal minutes).  When finished 

highlight OK>ENTR>QUIT. 

 Deleting a waypoint:  FIND (Waypoints highlighted)>ENTR to open Waypoints page.  Highlight desired 

waypoint>ENTR to open page for that waypoint.  Highlight Delete>ENTR.  Confirmation message 

appears:  Highlight Yes>ENTR. 
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 Tracks, an electronic “bread crumb” trail with location, elevation, date and time 

 Clear track log:  MENU>MENU(Tracks highlighted)>ENTR, highlight Clear>ENTR.  Confirmation message 

appears:  Highlight Yes>ENTR 

 Set up track log for track points every 0.01 mile (or whatever):  MENU>MENU (Tracks 

highlighted)>ENTR, highlight Setup>ENTR opens Track Log Setup page.  Highlight Record Method>ENTR, 

highlight Distance>ENTR.  Highlight Interval>ENTR opens on‐screen keypad.  Use it to enter 0.01, and 

then highlight OK>ENTR.  For even greater accuracy change Distance from miles to yards and pick 4 or 5 

yards: MENU>MENU>Setup>Units.  Highlight Distance/Speed>ENTR>, highlight Yards>Enter.  Then 

choose the yards you wish similar to first sentence above. 

 Save a track log (filters active track points from as many as 10,000 down to 500):  MENU>MENU (Tracks 

highlighted)>ENTR, highlight Save>ENTR.  Message asking to save entire track appears, highlight 

Yes>ENTR.  Highlight OK>ENTR.  Track is saved with default name of today’s date; make sure you see it 

under Saved Tracks.  Hit QUIT as many times as needed to take you back to one of the main pages. 

 Delete a saved track:  Go to Tracks page as described three times above.  Highlight the track you wish to 

delete>ENTR opens Saved Track page.  Highlight Delete>ENTR and a confirmation message appears, 

highlight Yes, ENTR to delete this saved track. 

 Delete all saved tracks:  Go to Tracks page as described above.  MENU, highlight Delete All Saved>ENTR 

and a confirmation message appears, highlight Yes>ENTR to delete all saved tracks. 

 TracBack:  At the end of a hike (such as bushwhacking), TracBack takes you back to where you started 

following the same track with turn by turn prompts.  I rarely use TracBack as viewing a loaded track is 

just as good for me. 

 Routes:  A sequence of intermediate waypoints that take you to your destination.  An example of their use 

would be bushwhacking around obstacles such as ponds, lakes, mountains, or hills.  See manual; I rarely use 

routes. 

 Load waypoints and tracks from GPS unit into MapSource Topo:  With GPS on and connected with USB 

cable, click   (Receive from device), make sure Waypoints and Tracks are ed>Receive>OK. 

 

Logging GPX Tracks to Micro SD Data Card  

(Saving Tracks filters a track from up to 10,000 track points down to 500 or less.  The filtering is only semi‐good, as you 

do lose some accuracy.  By logging to GPX files there is no loss in track accuracy.) 

1. With GPS on: MENU>MENU>ENTR takes you to Track page.  Highlight Setup>ENTR.  Highlight Data Card 
Setup>ENTR. 

2. Make sure Log Track to Data Card is ed; if not press ENTR.  QUIT, QUIT,… as many times as needed to take you 
back to whatever page you want, such as Map page. 
 

Retrieving GPX Tracks Sent to Micro SD Data Card  

(poorly documented in the manual) 

1. With GPS on and connected with the USB cable, press MENU>MENU, highlight Setup>ENTR, highlight 

Interface>ENTR, highlight USB Mass Storage>ENTR.  A removable disk (perhaps G:, H:, I:, or J:) for your GPS 

opens in Windows Explorer on your computer showing the logged GPX files by date.  You can then drag these to 

copy them to a folder on your computer.  You will see something like this upon opening the GPX files on your 

Micro SD card: 
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I drag them to a new folder I created called “GPX files from 60CSx” that is located in “Documents.”  These files are 

shown by date (e.g. “20080723”) so I rename them to something more meaningful, such as “M13 East 20080723.”  

Disconnect USB cable to leave this “Retrieving GPX Tracks” mode and restart your GPS. 

Want Accuracy in your Odometer and Track? 

You won’t get accuracy if the GPS unit is close to your body, particularly if it is low on your body, such as on your belt.  It 

is well known that your body interferes with the reception of the satellite signals.  Odometer and track distances can be 

off by quite a bit, depending on the density of the canopy and how low the GPS is attached to your body.  For better 

accuracy use an external amplified antenna Velcroed to top of your hat; such as I always use for GPSing the FLT. 

Appendix: How to download free New York Topo Map: 

There is now a free New York Topo map that you can view in the "Trip & Waypoint Manager" that comes free with 
Garmin handheld units. The direct link to the New York Topo map is http://www.gpsfiledepot.com/maps/view/111/.  
 
This is a 1:24,000 map, with 10 and 20 ft contours, showing topography, roads, water (lakes, rivers, streams), and 
railroads.  And this free map has more detail, as Garmin Topo U.S. is only 1:100,000 scale. 
 
Once downloaded and installed (click the _install.exe file) the New York Topo map is automatically available in Trip & 
Waypoint Manager or Garmin MapSource Topo or Garmin City Navigator.  NY Topo is available as a new item in your 
Garmin software in the dropdown box in the upper left of your computer screen (this box says "Select a Product" if you 
hover your mouse cursor over it). 
 
Gpsfiledepot.com is a nice site to know about if you have a Garmin GPS. There are 24K maps for many states, as well as 
road maps, maps for multi‐state regions, etc. 
  
Need help with loading the maps into your Garmin GPS?  Go to http://www.gpsfiledepot.com/tutorials/how‐to‐load‐
maps‐on‐my‐garmin‐gps‐unit/. You can load more than one map set, as long as all map sets are loaded at the same 
time! (previous maps on your Micro SD card are erased, but not the GPX data logging). 
  
Want to switch maps sets on your Garmin GPS unit?  Go to http://www.miscjunk.org/mj/mp_mapset.html. 

‐Java Joe, FLTC GIS Guy – kabjnd@msn.com, with help from Roger Hopkins, Ken Reek, and Don McClimans 
 
60CSx Detailed Instructions.doc – Oct. 22, 2011 
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Using FLT GPS Data in Delorme PN‐20 and PN‐40 GPS Units 
 
 

To import .gpx files of FLT trails and waypoints into Delorme TopoX software: 

1. Open Delorme TopoX; open a NEW file.  

2. Click on the DRAW tab; click on FILE, then IMPORT. This opens the IMPORT DRAW FILE dialog box.  

3. Pull down the LOOK IN field at the top and browse to the drive where the CD is; double click it. Using your paper 

maps as a reference, highlight the map name and click OPEN. The track and waypoints are now displayed over 

the base map on the computer screen. 

4. Before you leave the DRAW tab, highlight each file and click SAVE, then DONE. To save the base map location, 

track and waypoints as a PROJECT, click on MAP FILES, then FILE, SAVE AS‐<a name of your choice> 

To transfer .gpx files to your Delorme PN 20/40 GPS unit: 

1. Connect the unit to your computer with the USB cable. 

2. Click on the EXCHANGE icon at the top of the screen (either a monitor or GPS unit, depending on version, with 

left and right arrows). This will bring up the EXCHANGE dialog box. 

3. On the left side of the dialog box, expand the plus next to TRACK layers. 

4. Highlight the map name and click SEND, then DONE. 

5. On your PN 20/40, press MENU; scroll down to TRACKS, press ENTER. 

6. Scroll down to the map name; press ENTER. 

7. Scroll to VIEW; press ENTER. The track and waypoints are now displayed on the PN 20/40 screen for the selected 

map. 

8. On the PN 20/40, to close out of the saved map, press QUIT. Scroll to HIDE, press ENTER. Press PAGE to select a 

screen of your choice. 

 

The above provided by Lyn Jacobs; thanks! 

 
 
 
 
 
 
 
 
 
 
 
 
 
Delorme GPS Units.doc 
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Detailed Instructions for Using FLT GPS Track and Waypoint Data in Newer Garmin Units – 
Oregon, Dakota, and Montana Touch Screens (and Similar 62 and 78 Units) with BaseCamp 

 

You should run WebUpdater with your GPS unit occasionally to obtain the latest software for your GPS unit 
(especially newer models); download it at http://www8.garmin.com/products/webupdater/howtoinstall.jsp 
 
Please quickly scan all these pages to see what is on them before getting into the details. 

 

 Waypoint Abbreviations in FLT .gpx Files: 

 Jct = Junction, CR = County Route, Trl = Trail, Crk = Creek, N 

= North, E = East, S = South, W = West. 

 Waypoint Symbols: 

   Denotes a hunting closure.  M19aO15D20 means 

“Map M19, Oct. 15 – Dec. 20.”  The first on this map is 

labeled “a,” the second “b,” etc.  M19aMay means a 

hunting closure for whole month of May.  Note the red 

track (M19X1HntClose is a track name) shows the extent 

of the closure.   

  Denotes trailhead waypoints with parking. 

  Means no parking is available at this trailhead. 

 Tracks: 

 Main trail (white blazes) is black, orange trails are dark 

yellow, blue trails are blue, and hunting closures are red. 

BaseCamp Basic Info: 

1. "Help" in BaseCamp is excellent, brief and to the point.  Click Help>Help. 

2. If you are familiar with Google Earth, BaseCamp works in a similar manner, with similar controls and automatic 

saving of all files in "My Collection" (under "Library" on left) when exiting BaseCamp. 

3. You bring files into "My Collection" with File>Import…   

4. When deleting an imported file, you would normally choose "Delete List and Contents" as "Remove List" does 

not remove its contents from "My Collection." 

5. Nice: once in "My Collection" (and clicking "My Collection) you can view tracks and waypoints of multiple files 

(not possible in the earlier MapSource).  You can also (more important in MapSource) open multiple instances of 

BaseCamp and copy and paste tracks and waypoints between them.  For example, you can open a second 

instance of BaseCamp, import Public Land Boundary tracks for a map into it, copy them (hold down "ctrl" to 

select more than one, right click, select "Copy"), go to the first instance of BaseCamp, right click on where you 

want to put them, and select "Paste." 

6. Connecting your newer Garmin GPS unit with a USB cable brings the GPS unit (and its Micro SD card, if installed) 

into BaseCamp on the left under "Devices." 

7. Right‐clicking on a file or device brings up a menu of things you can do with its data, such as "Send To " (a file 

or device listed on left) or "Export…" (Save as a file on your computer). 

Back on trail; 

on GPS I can 

see it is to my 

right! 

Realize 

I’m lost! 

Official FLT 

GPX “Saved 
Track” 

My hiking 

(active) track 

following old 

false trail not 
blackened out 

My actual hiking experience on the 
western FLT.
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8. A nice feature is being able to view your BaseCamp track and waypoint data in Google Earth (must be installed) 

with View>All Data in Google Earth. 

9. You can buy "Birdseye View" aerial photos (unlimited downloads for one unit for a year) from Garmin for 

$29.95; not much help in deep woods, but useful when traversing fields or following hedgerows. 

10. In BaseCamp 3.2.2 there is a data management tool available after clicking "swap map and data views" (  ‐ find 

this between the left and right panes).  This allows you to display only certain items in the window above it (such 

as only tracks or only waypoints in a file or device):    (43 waypoints 

are highlighted here, thus are shown below). 

 

Download New York Topo: 

Follow the directions in the Appendix at the end of these instructions to download the free 24K New York Topo Map.  It 

will automatically become available as a map product option in BaseCamp.  We will also load it into your GPS unit later, 

even if your Garmin GPS unit is a "t" unit (with less accurate 100K topo maps for U.S. already installed). 

Preliminary BaseCamp Work: 

1. Download BaseCamp (either PC or Mac version) free at www.garmin.com/garmin/cms/us/onthetrail/basecamp. 

2. Start BaseCamp on your computer.  Click on Help>Help at the top and at least read through the "Getting 

Started" section, if not more. 

3. Make sure the Menu Bar at the top shows at least the following (If not, right click on the menu bar to choose 

options that are not checked (), like Edit). 

 

4. Hover your cursor over each tool to see what it does and become familiar with their names.  For example   

says “Zoom” (try it by clicking on it, then drawing a rectangle around an area!) and    says “Hand Tool.”  Hand 

Tool allows you to drag the map if you hold the left mouse button down as you drag (try it). 

5. Note the Garmin triangle   in the upper left.  Hover your mouse over it and becomes tools similar to those in 

Google Earth, allowing zooming in/out or rotating from north. 

6. The “Selection Tool”   is an important tool; by dragging it across the map you can select items such as tracks 

and waypoints (for such things as copying, and then later pasting). 

7. Your GPS unit: Connect your GPS unit to your computer with a USB cable.  Wait until you see a picture of the 

GPS connected to a computer on your unit and your unit appears on the left side of BaseCamp under "Devices" 

(you can close or minimize other windows that open). 

8. If you have current tracks and waypoints on your unit that you would like to send to BaseCamp's "My Collection" 

or save as a file, please see item 4. on Page 1.  If saving, give the file a meaningful name such as "M19 east ‐ Nov 

12 2010."  All listed tracks are saved, this includes Archived and Saved tracks.  You can also edit tracks and 

waypoints before you send or save them (see Help for "Working with Waypoints" or "Tracks").  
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9. Important Side Note: It is easiest to delete a number (or all) Saved or Archived Tracks with BaseCamp (or 

Windows Explorer), as in your GPS unit you can only delete one track at a time.  Hold down "Ctrl" key and click 

on the ones you wish to delete, then right‐click and select Delete. 

10. For out hiking: Make sure track logging is turned on in order to see your “bread crumb” current track on the map 

page: From Main Menu>Setup>Tracks>Track Log>Record>Record, Show on Map. 

11. Here’s how to Reset Trip Data and delete the Current Track or All Waypoints.  From Main Menu>Setup>Reset> 
and choose the option(s) you want. 

Load NY State Topo into Your GPS:   

Note: you should purchase a 2 GB (~$10) or larger Micro SD card so you can load New York Topo that you downloaded 
on Page 1 onto it (especially recommended if you have a "t" model with topo maps already on it!)  However, probably 
your GPS unit has room (New York Topo is 180 MB) to load this map directly into the memory of your GPS unit.   

1. Make sure BaseCamp is running and your GPS unit is connected with the USB cable. 
2. If you installed a Micro SD card (recommended!), right‐click the "Removable Media" for it that opened when you 

attached your GPS (otherwise right‐click your GPS unit) and click "Install Maps", starting the MapInstall wizard. 
3. Follow the instructions, but note the following: 
4. If the wizard asks you "Would you like MapInstall to automatically select maps around your waypoints, routes, 

and tracks?" click No. 
5. When the screen appears asking you to select maps, make sure "New York Topo" appears in bottom left.  Drag a 

rectangle to select all maps in New York State (or at least those you want in upstate New York). 
6. If you have loaded other 24K state topos from www.gpsfiledepot.com, click the drop down box to choose those 

states and select those maps. 
7. Finish the wizard to build your map sets and install the map on the device you chose.  This will take a few 

minutes. 
8. Note: If later you want to add other topo maps (for other states) you will need to go through all the above again 

for New York and the other states as only one map image file can exist (in the Garmin directory as 
gmapsupp.img) 

One FLT Map at a Time: Load FLT Tracks and Trailhead Waypoints to GPS 

1. In BaseCamp, click File>Import…  Browse to the folder where you stored the FLT GPX files (e.g. CD they came on, 
or where you hopefully copied them [e.g. My Documents\FLT GPX Files or C:\FLT GPX files]).  Open this folder.  
You should see the 55 .gpx map files, one for each map.  Highlight (scroll to) the one you want, click on it, then 
click Open.   

2. Tracks and waypoints for that map open and that map appears under "My Collection" on left.  Note that the 

bottom left panel shows the tracks and waypoints listed alphabetically.  Click on "Show Tracks"   at very 
bottom left to show only the tracks.  Right‐click on one of these, then "Show on Map" to bring that track into 
view. 

3. You may wish to delete some of these tracks.  For example, you may not be hiking during hunting seasons, so 
you might wish to delete any “Hntclose” tracks.  To do so, simply right‐click on them in the bottom left panel, 
then click “Delete”. 

4. Make sure your GPS is connected to computer with the USB cable.  Under "My Collection" right‐click on the map 
that you imported, click "Send to" and choose the name of your GPS unit.  Tracks and waypoints from the map 
you selected are sent to your GPS unit. 

5. To check that the tracks are there, disconnect and turn on your GPS unit.  From Main Page>>>Track 
Manager; they should be listed below "Current Track."  Note! To be visible on your GPS unit, tracks must be set 
to "Show on Map". 

6. Repeat the above for any other maps you wish to load. 
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Loading More than One FLT Map at a Time to Your GPS Unit 

1. For doing this you will not be using BaseCamp.  Simply plug the USB 
cable into your computer and your GPS.  A window similar to the 
one on far right opens :  

2. Choose "Open folder to view files using Windows Explorer." 
3. Windows Explorer opens and you should see similar to the 

following on its left side (may need to 
scroll down) :  

4. Click on the   to the left of the 

"Garmin" folder and then click on the   
to the left of left of the "GPX" folder.  You 
should see the following :  

5. Now within Windows Explorer navigate 
to the CD with the 55 GPX files (or the 
folder you copied them into on your C: 
drive) and click on the maps you wish to 
load, holding down "ctrl" or "shift" keys 
while doing so.  

6. You will see something like 
this :  

7. Right‐click on the files you 
have selected (B1 to B3 in 
this example) and click 
"Copy".  Click on the 
Garmin GPX folder so that 
it is highlighted.  Right‐click 
on it and click "Paste".  The 
GPX files are now copied 
into the GPX folder on your 
GPS unit (An alternative to 
Copy and Paste: Hold down 
left mouse button and drag 
the selected files into the 
Garmin GPX folder).  You 
should see the similar to 
the below in the Garmin GPX folder : 

 
8. You will not see the tracks and waypoints for these (in your GPS device) immediately in BaseCamp, if you have it 

running while you did the above.  You must disconnect and then reconnect your GPS unit to see the tracks and 
waypoints for these in BaseCamp. 
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9. Repeat steps 5. ‐ 7. in this section to add other GPX files (such as the free Public Land Boundary tracks). 
10. You should now go to Step 5. in the previous section. 

Out in the Field, Ready to Hike at Trailhead 

1. Turn GPS on.  Wait for satellites to be acquired (green bars at bottom of Main Menu); press the bars to see 
satellites and GPS Accuracy.  Here’s how to Reset Trip Data and delete the Current Track or All Waypoints: From 
Main Menu>Setup>Reset> and choose the option(s) you want.  Trip Computer page is cleared. 

2. Make sure the track for the trail you are hiking is visible (see 5. on page 3 for how to this with Track Manager). 
3. From Main Menu press Map to go to Map page.  Press "+" to zoom in and "‐" to zoom out.  Press these until 

scale near top is 500 ft or less (I often have the scale at 80 ft). 
4. Start hiking.  If you lose the trail, look at your GPS, perhaps zooming in (+) to see where the real trail track is 

relative to your position. 

Saving Batteries 

 Use NiMh rechargeable batteries:  Alkaline batteries do not last long in these units; sometimes only a couple of 
hours, depending on your settings.  Use rechargeables with at least 2000 mAh capacity. 

 Turn on "Battery Save:  From Main Menu>Setup>Display>Battery Save>On.  This results in big battery savings as 
the screen display is turned off after whatever time the Backlight Timeout is set for.  Touch any button to turn 
the screen display back on. 

 Set orientation to "North Up" and not "Track Up":  Main Menu>Setup>Map>Orientation>North Up.  This also 
refreshes the screen faster. 

 Turn off electronic (magnetic) compass:  From Main Menu>Setup>Heading>Compass>Off.  Note: electronic 
compass must be recalibrated each time you change batteries, and is of no use if you are moving. 

 Turn off backlighting:  Backlighting is not needed except in poor light conditions.  Press power button 
briefly>press "‐" until illumination is low.  Note: you can always reset this by pressing the power button briefly.  

Other Useful Information 

 Waypoints, a location on the map 

 Creating waypoints: 

 Where you are:  Mark Waypoint. 

 Using latitude and longitude:  Mark Waypoint>Save and Edit>Change Location>Edit the degrees and 
decimal minutes. 

 Deleting a waypoint:  >>Waypoint Manager>Press the one you want>Delete Waypoint. 
 Tracks, an electronic “bread crumb” trail with location, elevation, date and time 

 Clear Current Track log:  Setup>Reset>Clear Current Track>Yes. 

 Set up track log for track points every 0.01 mile (or whatever):  Setup>Tracks>Record 
Method>Distance>Interval>000001.  Note that if you want greater distance accuracy you can change the 
distance units to yards: Setup>Units>Distance/Speed>Yards, then change the interval per first sentence. 

 Save Current Track (saves up to 10,000 track points per track, max is 200 Saved Tracks):  >>Track 
Manager>Current Track>Save Track (Default is Date with Time)>. 

 Saving Saved Tracks on your computer: This can only be done with the GPS unit connected to your 
computer: See 9. Side notes near top of page 2. 

 Delete a saved track: >>Track Manager>Pick the Track>Delete>Yes. 

 Delete all saved tracks: This can only be done with the GPS  unit connected to your computer: See 9. 
Side notes near top of page 2. 

 Routes:  A sequence of intermediate waypoints that take you to your destination.  An example of their use 
would be bushwhacking around obstacles such as ponds, lakes, mountains, or hills.  See manual; in the type 
of hiking I do I have rarely used routes. 

 Load Waypoints and Current Track from GPS unit into BaseCamp:  Connect with USB cable.  Right‐click your 
GPS unit>Send to >My Collection.  If you wish to save your data into a separate file choose Export… 
instead of Send to . 
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Want Accuracy in your Odometer and Track? 

You won’t get accuracy if the GPS unit is close to your body, particularly if it is low on your body, such as on your belt.  
Your body interferes with the reception of the satellite signals.  Odometer distances can be off by quite a bit, depending 
on the density of the canopy and how low the GPS is attached to your body.  For better accuracy wear the unit Velcroed 
to the top of a shoulder strap of a day pack, or if your unit allows (Montana, 62, 78 models) use a Gilsson amplified 
external antenna (~$20)  Velcroed to the top of your hat. 

Appendix: How to download free New York Topo Map: 

There is now a free New York Topo map that you can view in BaseCamp. The direct link to the New York Topo map is 
http://www.gpsfiledepot.com/maps/view/111/.  
 
This is a 1:24,000 map, with 10 and 20 ft contours, showing topography, roads, water (lakes, rivers, streams), and 
railroads.  And this free map has more detail, as Garmin Topo U.S. is only 1:100,000 scale. 
 
Once downloaded and installed (click the _install.exe file) the New York Topo map is automatically available 
in BaseCamp.  NY Topo is available as a new item in BaseCamp in the dropdown box in the upper left of your computer 
screen (this box says "Select a map product to display" if you hover your mouse cursor over it). 
 
Gpsfiledepot.com is a nice site to know about if you have a Garmin GPS. There are 24K maps for many states, as well as 
road maps, maps for multi‐state regions, etc. 
  
Need help with loading the maps into your Garmin GPS?  Go to http://www.gpsfiledepot.com/tutorials/how‐to‐load‐
maps‐on‐my‐garmin‐gps‐unit/. You can load more than one map set, as long as all map sets are loaded at the same 
time! (previous maps on your Micro SD card are erased). 
  
Want to switch maps sets on your Garmin?  Go to http://www.miscjunk.org/mj/mp_mapset.html. 

‐Java Joe, FLTC GIS Guy – kabjnd@msn.com, with help from Roger Hopkins, Ken Reek, and Don McClimans 
 
Garmin Oregon Detailed Instructions with BaseCamp.doc – Oct. 22, 2011 
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Our GPS data also works with smart phones with GPS capabilities, such as Droids.  
 

I've reviewed six GPS hiking "apps" for Droids and recommend the two below. The trick: Once on your computer you can 
copy the FLT GPX data to the data card of a smart phone plugged into a USB port. Both the Droid and its data card are 
opened as drives in Windows Explorer where you can "copy and paste" or "drag and drop" the GPS files you want onto 
the data card.  

1. Backcountry Navigator, $9.99 (but there is a 16 day free demo for you to try): It loads both our track and 
waypoint data nicely, even retaining the waypoint symbols and labels. However, it is more complicated (and 
powerful) than the one below. 

2. My Tracks by Google, free. It can import our FLT track data, but can't import our waypoint data. It is easier to 
learn how to use than the above (and nice help screen quickly accessible), but only one loaded track can be 
viewed at a time. For example, if you want to view a loaded track, you cannot view the "active" track you are 
hiking at the same time, but the "triangular present location marker" is visible so you can see if you are following 
the saved track you have turned on. Although you can't import FLT waypoints, you can save waypoints along 
your track as you hike and send both the track and all waypoints to your data card (or directly into Google Maps - 
"My Maps", where you can view and share with others). 

 

 


